
Микроскоп Andonstar 
Модели 266S, 269S

Инструкция по эксплуатации 



2 
 

Содержание 

1 Комплектация ................................................................................................................................... 3 

2. Сборка устройства .......................................................................................................................... 4 

2.1 Кнопки и разъемы ..................................................................................................................... 4 

2.2 Кронштейн и внешнее освещение .......................................................................................... 5 

3. Быстрый старт ................................................................................................................................. 6 

3.1 Как выбрать объектив ............................................................................................................... 6 

4 Сохранение фото и видео .............................................................................................................. 11 

4.1 Запись видео ............................................................................................................................ 11 

4.2 Съемка фото ............................................................................................................................ 11 

4.3 Воспроизведение и управление файлами ............................................................................. 11 

5 Дистанционное управление .......................................................................................................... 12 

6 Настройки ....................................................................................................................................... 13 

6.1 Настройка линии сетки .......................................................................................................... 13 

6.2 Сохранение настроек .............................................................................................................. 15 

7 Два режима вывода ........................................................................................................................ 15 

8 Безопасность и техническое обслуживание ................................................................................ 22 

9 Часто задаваемые вопросы (FAQ) ................................................................................................ 23 

 



3 
 

1 Комплектация 

1 Монитор микроскопа 10 Пульт дистанционного управления 

2 Объектив A (установлен на 
микроскопе) 

11 Адаптер питания 

3 Основание 12 HDMI-кабель 

4 Колонна 13 USB-кабель 

5 Внешние светодиодные лампы 
(используются с объективами A, L) 

14 Сетевой кабель 

6 Комплект объективов B, C, M 15 Набор биологических препаратов 

7 Подвижный столик по осям X-Y 16 Пинцет 

8 Объектив L 17 Контейнер для наблюдения за насекомыми 

9 Фоновые пластины (3 шт.)   
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2. Сборка устройства 

Пожалуйста, ознакомьтесь с инструкцией по сборке, прилагаемой к упаковке, для 
получения подробной информации. 

2.1 Кнопки и разъемы 

 

1 Включение/выключение питания 8 Фокусировочная трубка 

2 Режим/Меню 9 Винты фиксации объектива 

3 Вверх / Цифровое увеличение 10 Кнопка сброса 

4 Вниз / Цифровое уменьшение 11 HDMI-порт 

5 OK / Начать запись 12 USB-порт 

6 Сделать снимок 13 Слот для SD-карты 

7 Приемник сигнала пульта 14 Интерфейс эндоскопа (только для 10-
дюймовой модели) 
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2.2 Кронштейн и внешнее освещение 

1 Регулятор высоты столика 4 Нижний источник света 

2 Регулируемый столик для 
наблюдений 

5 Разъем для нижнего освещения 

3 Отверстие для прохождения света 6 Разъем для внешних светодиодных ламп 
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3. Быстрый старт 

Пожалуйста, подключите устройство к источнику питания согласно изображению ниже. 
Устройство может автоматически включиться при подаче питания. Если оно не 

включается, нажмите и удерживайте кнопку питания (①), пока монитор не загорится. 

 

3.1 Как выбрать объектив 

Объектив A 
Диапазон фокусировки: 12 мм – 320 мм 
Увеличение: 18–720x (с 3-кратным цифровым зумом, при 

выводе на 28-дюймовый HDMI-монитор) 
Применение: Наблюдение за монетами, камнями, марками, 

печатными платами и другими объектами. 
 
 

 
 

Слот карты памяти 

USB интерфейс 

HDMI кабель 

Разъем 
сброса 

Подключите 

Яркость+ 

Яркость- Питание 
вкл/выкл 

Интерфейс 
точечных 
светильников 
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Использование объектива A для наблюдения за монетой 
 
Шаги: См. схему наблюдения за монетой с использованием объектива A на 

изображении выше. 
Рекомендуется использовать внешние светодиодные лампы при работе с объективом A. 

(Пожалуйста, подключите штекер источника света к разъему ⑥). 
1. Установите и зафиксируйте объектив A. 
2. Поместите черную (или белую) фоновую пластину в отверстие для прохождения света 

в нижнем источнике освещения и положите монету на пластину. 
3. Отрегулируйте высоту столика для наблюдений, чтобы изменить расстояние между 

объективом и объектом. Эффективное расстояние для объектива A: 12 мм – 320 мм. Чем 
меньше расстояние, тем больше увеличение.  

Поверните фокусировочную трубку: 
По часовой стрелке – для увеличения масштаба. 
Против часовой стрелки – для уменьшения масштаба. 
4. Отрегулируйте яркость и угол внешних светодиодных ламп, чтобы свет правильно 

освещал монету. 
*Этот метод также подходит для наблюдения за растениями, камнями и другими 

объектами. 



8 
 

Комплект объективов B, C, M 
Объектив B: 
Диапазон фокусировки: 7 мм – 8 мм 
Увеличение: 1560x – 2040x (с 3-кратным цифровым 

зумом, при выводе на 28-дюймовый HDMI-монитор) 
Объектив C: 
Диапазон фокусировки: 3 мм – 4 мм 
Увеличение: 2760x – 4080x (с 3-кратным цифровым 

зумом, при выводе на 28-дюймовый HDMI-монитор) 
Объектив M: 
Диапазон фокусировки: 0,5 мм – 0,7 мм 
Увеличение: 3600x – 5100x (с 3-кратным цифровым 

зумом) 
Применение: 
Используется для наблюдения за биологическими препаратами (микроскопическими 

стеклами и срезами). 

Использование объектива M для наблюдения за биологическими препаратами 
 
Шаги: См. схему наблюдения за биологическими препаратами с объективом M на 

изображении выше. 

Объектив M 
Диапазон 
фокусировки: 0,5 
мм – 0,7 мм 
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Важно! При использовании объективов с высоким увеличением внешние светодиодные 
лампы не требуются. Подключите источник света напрямую к основанию и используйте 
нижний источник освещения. 

1. Установите и зафиксируйте комплект объективов B, C, M. 
2. Закрепите биологический препарат с помощью металлических зажимов на 

подвижном столике X-Y. 
3. Отрегулируйте высоту столика, чтобы приблизить объектив к объекту. 
Эффективный диапазон расстояний объектива M: 0,5 мм – 0,7 мм. Чем меньше 

расстояние до объекта, тем больше увеличение. 
Поверните фокусировочную трубку: 
По часовой стрелке – для увеличения масштаба. 
Против часовой стрелки – для уменьшения масштаба. 
4. Точно настройте координаты по осям X и Y с помощью подвижного столика для 

плавного перемещения препарата. 
Если необходимо уменьшить увеличение, поверните револьверное устройство и 

выберите объектив B или C. 
Объектив B: 7 мм – 8 мм. 
Объектив C: 3 мм – 4 мм. 
Отрегулируйте высоту столика для достижения фокусировки. 
Дополнительные замечания: 
Комплект объективов B, C, M обладает очень большим увеличением и малым 

диапазоном фокусировки. Даже небольшие движения могут вызвать дрожание изображения 
на экране. Это нормальное явление, поэтому настройку необходимо выполнять аккуратно и 
терпеливо. 

Объектив L 
 
 
Диапазон фокусировки: 90 мм – 300 мм 
Увеличение: 60x – 240x (с 3-кратным цифровым зумом, при 

выводе на 28-дюймовый HDMI-монитор) 
Применение: Наблюдение и ремонт печатных плат, 

электронных компонентов и других технических объектов. 
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Использование объектива L для наблюдения за печатной платой 
Шаги: См. схему наблюдения за печатной платой с использованием объектива L на 

изображении выше. 
Важно! При использовании объектива L рекомендуется использовать внешние 

светодиодные лампы. 
1. Установите и зафиксируйте объектив L. 
2. Отрегулируйте высоту столика, чтобы установить нужное расстояние между 

объективом и объектом. 
Эффективный диапазон расстояний: 90 мм – 300 мм. 
Чем меньше расстояние до объекта, тем больше увеличение. 
Поверните фокусировочную трубку: 
По часовой стрелке – для увеличения масштаба. 
Против часовой стрелки – для уменьшения масштаба. 
3. Отрегулируйте яркость и угол светодиодных ламп так, чтобы свет правильно освещал 

печатную плату. 
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4 Сохранение фото и видео 

Вставьте карту памяти. 
Важно! Карта памяти не поддерживает «горячую» замену (не вытаскивайте и не 

вставляйте карту во включенном устройстве). 
 

4.1 Запись видео 

Верхний левый угол экрана показывает текущий режим: 

Режим видео ( ) / Режим фото ( ) 
Нажмите кнопку "OK", чтобы начать запись. Нажмите "OK" снова, чтобы остановить 

запись.  
Те же функции выполняет кнопка "OK" на пульте управления. 

4.2 Съемка фото 

В режиме видео ( ), режиме фото ( ) или во время записи видео нажмите кнопку 

( ), чтобы сделать снимок. 
Кнопка съемки на пульте управления выполняет ту же функцию. 

     В режиме воспроизведения микроскоп не может делать фото и видео. 
 

4.3 Воспроизведение и управление файлами 

Нажмите кнопку "M", чтобы войти в режим воспроизведения. Нажимайте "вверх" или 
"вниз", чтобы переключать файлы. 

Для воспроизведения видео: 
Нажмите "OK" – воспроизведение. 
Нажмите "OK" снова – пауза. 
Нажмите "M" – остановка видео. 
Во время просмотра фото или видео удерживайте кнопку "MENU" (M), чтобы управлять 

файлами. 
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5 Дистанционное управление 

Примечание: Кнопка «Переключение изображения объектива» доступна только после 
подключения эндоскопа. 
  

Меню 

Стоп-кадр 

Яркость - 

ОК/начать 
запись видео 

Вкл/выкл Wi-Fi 

Резкость + 

Резкость - 

Контраст- 

Инверсия 

Поворот 
изображения 

Сделать 
фотографию 

Режимы 

Увеличение 

Яркость + 

Уменьшение 

Перекрестие 

Заблокировать/разблокировать файл 

Контраст + 

Переключение изображения 
объектива 

Сброс настроек 

Черно-белый режим 
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6 Настройки 

① Длительное нажатие кнопки "M" в режиме ожидания видео откроет видеоменю 

 
Видео меню 

 
② Нажмите "M", чтобы переключиться в режим фото, затем удерживайте "M", чтобы 

открыть меню фото: 

 
 
(Pис. 8: Меню изображений) 
 

6.1 Настройка линии сетки 

Используйте кнопки "Вверх" и "Вниз" на пульте для переключения между следующими 
параметрами: 

• Перекрестие (cross line) 
• Линия (line) 
• Направление (direction) 
• Позиция (position) 
• Цвет (color) 
• Ширина (width) 

 
Используйте кнопки "Влево" и "Вправо" на пульте для изменения значений выбранного 

параметра. 
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Меню настройки линии сетки   Перекрестие включено 

Линия 1, горизонтальная, координата 160      Линия 1, вертикальная, координата 266) 

Установка цвета линии 1 в прозрачный 
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6.2 Сохранение настроек 

Чтобы сохранить настройки, после их изменения удерживайте кнопку питания, чтобы 
выключить устройство. 

     Если отключить питание напрямую, настройки не будут сохранены. 
 

7 Два режима вывода 

Выход HDMI (HDMI output) – позволяет передавать изображение на внешний экран 
через HDMI. 

 
 

Подключение по HDMI 
 
 
 

HDMI кабель 

Подключите 

Яркость+ 

Яркость- 

Питание 
вкл/выкл Интерфейс 

точечных 
светильников 
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USB-выход (USB Output) 
1. Установка программного обеспечения 
Где скачать ПО: (Введите ссылку с учетом регистра букв) – https : / / bit.ly/3TcQVGw 
*Поддерживаемые системы: Windows XP SP3, Windows 7, Windows 8, Windows 10, 

Windows 11 

*Необходимые компоненты: Microsoft .Net Framework 4.0; Microsoft Visual C++ 2010 
Runtime 

     Если какой-либо из этих компонентов не установлен полностью, во время установки 
появится ошибка. 

 
2. Подключение к ПК 

Подключение по USB 
 
1) Требуемые устройства: ПК с Windows и установленным ПО “Microscope Measure”; 

USB-микроскоп (имя устройства: "USB Camera"); Линейка 
2) Подключите микроскоп к компьютеру с помощью USB-кабеля (см. изображение 

выше). 
3) На мониторе микроскопа или пульте нажмите кнопку "Вниз", выберите "PC Camera" и 

нажмите "OK". 

USB кабель 

Подключите к адаптеру 

Не используется 
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4) Откройте программу "Microscope Measure" на ПК. 
5) Перейдите в “Файл” → “Открыть” → “Открыть устройство” → “USB MODE” → “USB 

Camera”. 
 

3. Определения иконок 

 Увеличение  

 Нормальный масштаб (оригинальный масштаб) 

 Уменьшение 

 Отмена последнего действия 

 Перекрестные линии (крест-накрест, 4 сетки, 8 сеток) 

 Расстояние между 2 горизонтальными точками 

 Расстояние между 2 вертикальными точками 

  Расстояние между любыми 2 точками 

  Измерение прямоугольника (ширина, высота, периметр и площадь) 

 Измерение эллипса (радиус длинной оси, радиус короткой оси, периметр и площадь) 

 Измерение радиуса круга (радиус, периметр и площадь) 

 Измерение диаметра круга (диаметр, периметр и площадь) 

 Измерение 3-точечного круга (диаметр, периметр и площадь) 

 Измерение 3-точечной дуги (радиус, градус, периметр и площадь) 

 Измерение многоугольника (периметр и площадь) 

 Измерение линий сгиба (длина) 

 Измерение 4-точечного угла (градус) 

 Измерение трехгранного угла (градус) 

 Расстояние между параллельными прямыми (длина) 

 Расстояние между точкой и прямой (длина) 

 Расстояние между двумя окружностями (радиус, длина) 

 Расстояние между прямой и окружностью (радиус, длина)  

 Добавить метку квадрата 

 Добавить метку окружности 

 Добавить текст 

 Расстояние между 2 прямыми (длина)  

 Круг из 3 точек (радиус, периметр и площадь))  

 Распознавание краев 

 Увеличение/уменьшение яркости 

 Перевернуть по горизонтали (радиус, периметр и площадь) 

 Резкость 
 Сгладить 
 Сделать снимок 
 Снять видео 
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4. Определения и функции программного интерфейса 

 
1. Главное меню: 

• Позволяет открывать различные устройства, загружать изображения для 
наблюдения или редактирования, 

• Настраивать видеопараметры и параметры сохранения, 

• Выбирать, какие окна отображать или скрывать. 
2. Панель инструментов: 

• Включает инструменты для измерений и анализа изображений. 

• Описание всех инструментов находится в разделе «Определения иконок»  

• Панель можно показать или скрыть через меню: 
"View" → "Toolbars and Docking Windows" → "Standard". 

3. Обозреватель изображений: 

• Позволяет просматривать все сохраненные изображения. 

• Можно редактировать изображения, щелкнув правой кнопкой мыши и открыв их 
в главном рабочем окне. 

• Окно можно показать или скрыть через меню: 
"View" → "Toolbars and Docking Windows" → "Picture browser". 

4. Дополнительное операционное окно: 

• Показывает увеличенную область изображения под курсором. 

• Позволяет точнее проводить измерения. 

• Связано с окном "Обозреватель изображений" 
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5. Главное рабочее окно : 

• Отображает полный вид изображения с микроскопа. 

• В этом окне выполняются измерения и анализ изображений. 
6. Управление калибровкой и результаты измерений: 

• Оба окна располагаются в одном месте. 

• Можно переключаться между ними с помощью вкладки внизу окна. 

 
Управление калибровкой     Результаты измерений 

 
 
 
 
 

→ Отображает 

список доступных 
калибровок. 
Пользователь 
может применять 
или удалять 
выбранную 
калибровку. 

→ Позволяет 

добавлять новые 
калибровки 
(подробности 
настройки 
описаны в другой 
главе). 

→ Показывает размер 

всего наблюдаемого 
изображения. 
 
Можно изменить в: 
"File" → "Video setting" 

→ "Video capture pin" 

→ (S). 

→ Отображает все 

результаты измерений 
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5. Функциональные возможности ПО 
 
1) Калибровка 
1. Поместите линейку под цифровой микроскоп, 

отрегулируйте колесо фокусировки и высоту подставки, чтобы 
получить наилучшую четкость изображения. (Во время дальнейших 
шагов не изменяйте расстояние до объекта.) 

2. В "Calibration Management" задайте название и единицу 
длины для новой калибровки (см. изображение справа). Затем 

нажмите "Calibration", при этом значок "  " в панели 
инструментов должен активироваться автоматически. Если этого не 
произошло, выберите его вручную. 

3. Переместите курсор в главное рабочее окно и с помощью 
линейки нарисуйте линию равную единице длины, установленной 
в шаге 2. После этого нажмите "Finish" внизу окна "Calibration 
Management". 

4. Проверьте: Длина линии, нарисованной в шаге 3, должна 
соответствовать заданной единице измерения. Название новой 
калибровки должно появиться в списке калибровок. 

 
 
 
 
 

[3] 
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[4] 
2) Измерение 
1. Выберите необходимый инструмент для измерений в панели инструментов. 
2. В главном рабочем окне нажмите на точки или нарисуйте линии, которые требуется 

измерить. 
3. Разместите результаты измерений в подходящем месте вокруг целевого объекта. 
 
3) Специальные эффекты (Special Effect) 
Включает: Обнаружение краев, Инверсия цвета, Отражение по горизонтали, Рельеф, 

Резкость, Смягчение. 
Шаги: 
1. Выберите необходимый специальный эффект в панели инструментов. 
2. В главном рабочем окне удерживайте левую кнопку мыши, чтобы нарисовать 

прямоугольник, охватывающий всю целевую область. 
3. После этого отпустите кнопку – эффект будет применен. 
Щелкните левой кнопкой мыши еще раз, чтобы завершить применение эффекта. 
Примечание: 
Если хотите использовать "Отражение по горизонтали" (Flip horizontal), нарисуйте любой 

прямоугольник в поле зрения, после чего изображение перевернется. 
Щелкните левой кнопкой мыши еще раз, чтобы завершить применение эффекта. 
 
4) Съемка и запись 
Съемка 

1. Нажмите кнопку " " для создания снимка. 
2. В окошке "Picture browser" ("Браузер изображений") можно проверить и удалить 

результат захвата. 
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3. Проверьте и измените путь сохранения: “File→Save Setting→Path” ("Файл→Настройка 
сохранения→Путь"). 
 
Запись 

1. Выберите размер изображения 640*480 в “File→Video Setting→Video Capture 
Pin→Output size(S)” ("Файл → Настройка видео → Пин захвата видео → Выходной 
размер (S)").  

2. Нажмите кнопку " ", установите другие параметры и начните запись. 

 
3  В левом верхнем углу отображается надпись “recording” ("запись") и таймер. Это 

означает, что идет запись.  
4 Проверьте и измените путь сохранения: “File→Save Setting→Path” ("Файл→Настройка 

сохранения→Путь"). 
 

8 Безопасность и техническое обслуживание 

1. Храните устройство в чистом и сухом месте, вдали от масла, воды, газа и других 
веществ, которые могут вызвать коррозию. 

• Устройство содержит мелкие детали и не предназначен для употребления 
внутрь. 

• Используйте устройство под присмотром взрослых или учителей, чтобы 
избежать случайного проглатывания деталей детьми. 

2. Если качество изображения ухудшилось, протрите объектив сухой и мягкой тканью. 
3. Не нажимайте с усилием и не ударяйте по дисплею острыми предметами. 

• Для удаления пыли с экрана или корпуса используйте сухую и мягкую ткань. 

• Никогда не распыляйте воду или чистящие средства прямо на дисплей. 
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9 Часто задаваемые вопросы (FAQ) 

1. Почему микроскоп не включается? 
Проверьте цепь питания и источник питания согласно инструкции по установке. 
 
2. Почему я не могу получить четкое изображение? 
Отрегулируйте яркость светодиодного освещения, измените расстояние до объекта, 

повторно наведите фокус. 
Если изображение все еще размытое, аккуратно протрите объектив чистой хлопковой 

тканью. 
 
3. Почему не сохраняются настройки? 
После изменения настроек удерживайте кнопку питания, чтобы выключить устройство. 

     Если выключить устройство путем отключения кабеля питания, настройки не 
сохранятся! 

 
4. Почему после установки карты памяти TF появляется сообщение об ошибке, сбое 

или заполненной памяти? 
После установки карты отформатируйте ее перед первым использованием. 
Рекомендуется использовать качественные TF-карты класса 10 и выше. 
 
5. Почему при установке программного обеспечения измерения или запуске 

программы появляется сообщение о недостающем файле? 
Убедитесь, что в системе полностью установлены: Microsoft .Net Framework 4.0 и 

Microsoft Visual C++ 2010 Runtime. 
 
6. Программа установлена и запускается, но почему я не могу выполнять измерения? 
Убедитесь, что оборудование подключено правильно. На экране должен отображаться 

режим камеры. Нажмите "OK", чтобы активировать камеру. 
Если изображение не отображается, откройте диспетчер устройств операционной 

системы:  

• Удалите USB Video Device. 

• Отключите и повторно подключите USB-кабель. 

• Обновите список устройств, чтобы система снова распознала камеру. 

• Устройство должно отображаться как "USB Camera". 
 
7. Почему при измерении получается большая погрешность? 
Для точных результатов используйте высокоточный калибровочный масштаб. 
Во время измерений используйте те же фокусное расстояние и увеличение, что и при 

калибровке. 
Ошибки могут быть вызваны: 

• Неправильным калибровочным масштабом 

• Использованием неверного значения калибровки 

• Изменением фокусного расстояния и увеличения 

• Неправильной методикой измерения 
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8. Почему программа измерений не отображает изображение или показывает 
черный экран? 

• Убедитесь, что микроскоп подключен к компьютеру и выбран режим "PC Camera". 

• Используйте USB-кабель, а не кабель питания. 

• Проверьте настройки конфиденциальности компьютера. 

• Убедитесь, что в системе установлены Microsoft .Net Framework 4.0 и Microsoft 
Visual C++ 2010 Runtime. 

• Проверьте, не блокирует ли антивирус или брандмауэр доступ к камере. 

• В настройках конфиденциальности убедитесь, что доступ к камере разрешен. 

• Если микроскоп подключен, он должен отображаться в диспетчере устройств как 
"USB Camera". 

• Попробуйте другой USB-порт или другой компьютер для тестирования. 
9. Почему изображение не отображается при подключении к HDMI-монитору? 
Проверьте соединение микроскопа и HDMI-кабеля. Попробуйте заменить HDMI-

монитор. 
 
 
 
 


